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PPrreeffaaccee  

This document provides step-by-step instructions to install the Oracle Financial Services 

International Financial Reporting Standards Application Pack (OFS IFRS) 8.0.4.0.0 Minor 

Release. 

This chapter discusses the following topics: 

 Audience 

 How this Guide is Organized 

 Recommended Environment 

 Related Documents 

 Conventions and Acronyms 

Audience 

The OFS IFRS pack Installation and Configuration Guide is intended for administrators and 

implementation consultants who are responsible for installing and maintaining the application 

pack components. 

The document assumes you have experience in installing Enterprise components. Basic 

knowledge about the OFS IFRS pack components, OFSAA Architecture, UNIX commands, 

Database concepts, and Web Server/ Web Application Server is recommended. 

PPrreerreeqquuiissiitteess  ffoorr  tthhee  AAuuddiieennccee  

The document assumes that you have experience in installing Enterprise components and basic 

knowledge about the following is recommended.  

The following are the expected preparations from the administrator before starting the actual 

installation: 

 Oracle Financial Services Advanced Analytical Applications Infrastructure pack 

components 

 OFSAA Architecture 

 UNIX Commands 

 Database Concepts 

  Web Server/Web Application Server  

How this Guide is Organized 

The OFS IFRS pack Installation and Configuration Guide includes the following topic: 
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 OFS IFRS Release 8.0.4.0.0 

 Appendix A 

RReellaatteedd  DDooccuummeennttss  

For more information, refer to the OFS IFRS Pack 8.0.4.0.0 documents available in OHC 

Documentation Library. 

 Oracle Financial Services International Financial Reporting Standards Application Pack 

Installation Guide 8.0.2.0.0 

 Oracle Financial Services Loan Loss Forecasting and Provisioning User Guide 

8.0.4.0.0 

 Oracle Financial Services Hedge Management User Guide 8.0.4.0.0 

CCoonnvveennttiioonnss  aanndd  AAccrroonnyymmss  

Conventions Description 

Actions are indicated in Bold. 

Command or query is indicated in Courier New font. 

AIX Advanced Interactive eXecutive 

OFSAAI Oracle Financial Services Analytical Applications Infrastructure 

OFS AAAI Oracle Financial Services Advanced Analytical Applications Infrastructure 

Application Pack 

RHEL Red Hat Enterprise Linux 

ML Maintenance Level  

Atomic Schema Database schema where the application data model is uploaded. 

Config Schema Database schema which contains setup related configurations and metadata. 

DEFQ Data Entry Forms and Queries 

DML Data Manipulation Language 

EAR Enterprise Archive 

EJB Enterprise JavaBean 

ERM Enterprise Resource Management 

FTP File Transfer Protocol 

GUI Graphical User Interface 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
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Conventions Description 

HTTPS Hypertext Transfer Protocol Secure 

J2C J2EE Connector 

J2EE Java 2 Enterprise Edition 

JDBC Java Database Connectivity 

JDK Java Development Kit 

JNDI Java Naming and Directory Interface 

JRE Java Runtime Environment 

JVM Java Virtual Machine 

OHC Oracle Help Center 
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11  OOFFSS  IIFFRRSS  PPaacckk  RReelleeaassee  88..00..44..00..00  

This Minor Release of Oracle Financial Services International Financial Reporting Standards 

Application Pack (OFS IFRS) is cumulative and includes all enhancements and bug fixes done 

since the OFS IFRS Application Pack v8.0.2.0.0 GA release. For more information, refer to the 

Oracle Financial Services IFRS Release 8.0.2.0.0 Installation Guide in OHC Documentation 

Library. 

11..11  SSuuppppoorrtteedd  SSooffttwwaarree  VVeerrssiioonnss  

You can refer to the OFSAA Technology Matrix 8.0.4.0.0 in OHC Documentation Library to know 

more about the software versions that are supported by this release of OFS IFRS. 

11..22  PPrree  IInnssttaallllaattiioonn  RReeqquuiirreemmeennttss  

 You should have installed OFS IFRS Application Pack version 8.0.2.0.0 (using Full Installer).  

NOTE:  You can refer to Technology Matrix for Hardware and Software Requirements. 

 Bug 23251358-Object Registration is failing with duplicate Constraint Names is regularized in 

this OFS AAAI application pack 8.0.4.0.0. This is bundled as a utility - Update Constraints 

Utility and is executed as part of the 8.0.4.0.0 patch installation. You must perform the 

following steps and apply the change before you proceed further with the patch upgrade. 

NOTE:  This step is not required if the existing platform version is 8.0.3.x.x. 

 It is advised to take a backup of the atomic schema for each Information Domain in the 

OFSAA instance before applying the patch. 

 Execution of the utility is a memory intense process as the entire steps involved for 

performing a full model upload is carried out as part of the utility for each of the 

Infodom. The OFSAA installation server needs to have twice the allocated memory, 

which is assigned using parameter X_ARGS_APPS.  

 The utility creates three temporary tables- REV_TAB_CONSTRAINTS_U, 

REV_TAB_REF_CONSTRAINTS_U, and REV_TAB_CONSTRAINT_COLUMNS_U. If the 

atomic schema has any of these tables already created for a different purpose, take a 

backup and drop/ rename. 

 As in the model upload process, for the applications that follow logical model upload like 

OFS_AML in BD pack, the utility does not play any role, since the persistence of the 

model is outside the purview of the utility. Any similar cases, which involve only logical 

model upload should be considered and taken care of by the user. 

 For more information about the utility execution and log files information, see the 

Update Constraints Utility section. 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E55339_01/homepage.htm
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 To install this release on Oracle Solaris OS, refer to the following list for version-specific 

information: 

 Solaris 11 – Upgrade to Oracle Solaris 11.3 with SRU09 or higher. See 

https://docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc upgrade to 

SRU09 if you have a lower SRU version. Additionally, install the required runtime 

libraries. For more information, see Installing Only the Runtime Libraries on Oracle 

Solaris 11. 

 Solaris 10 – Install the required OS patches. For more information, see Installing the 

Required Oracle Solaris 10 Patches. Additionally, install the required runtime libraries. 

For more information, see Installing Only the Runtime Libraries on Oracle Solaris 10. 

NOTE:  In an OFSAA instance where multiple OFSAA application packs have been 

installed/ deployed, it is mandatory to upgrade all OFSAA application packs to 

8.0.4.0.0 release. You should start the upgrade of the OFS IFRS pack, only 

after confirming that all of the application packs in your OFSAA instance are 

available for upgrade to 8.0.4.0.0 version. For information on the availability of 

the required OFSAA Application Packs, see 2246606.1. 

 The PATH variable in the .profile file should be set to include the Java Runtime Environment 

absolute path. The path should include the java version (java 6, java 7, or java 8) based on 

the configuration. 

 OFS IFRS Application pack v8.0.4.0.0 installer download contains only the ERwin XML file 

that is required for uploading the model. This file is sufficient to install the v8.0.4.0.0 

Application pack. However, this XML file cannot be opened in the ERwin Data modeler tool 

and hence cannot be used for any data model customization. ERwin file is delivered as a 

patch and needs to be downloaded separately. This ERwin file should be used for any 

customization of the data model. To download the Data Model Erwin file, log in to 

https://support.oracle.com/ and search for 25595785 under the Patches & Updates tab. If 

customization to the data model has been done in the environment being upgraded, then 

before uploading the same, customizations need to be applied again in the merged data 

model. 

 If you are using Linux 7, ensure that the following patch is applied from the Patches & 

Updates tab of https://support.oracle.com/, before you proceed with the installation. 

 22930093 

 The values of sources (ETL_APP_1_NAME, ETL_SRC_1_1_NAME, and 

ETL_SRC_1_2_NAME) in silent.props file should be the same in both OFS ALM 8.0.2.0.0 

and OFS IFRS 8.0.2.0.0. 

https://docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gozsu.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gozsu.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gimhj.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gimhj.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gouag.html#scrolltoc
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=379120760831411&id=2246606.1
https://support.oracle.com/
https://support.oracle.com/
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 If no customization is required to the released model, then copy the file 

OFS_IFRS_Datamodel.xml present in the aforementioned patch to the location <<Extracted 

Installer Path>>/OFS_IFRS_PACK/OFS_IFRS/DataModel. 

 If customization is required, then customize/merge the Erwin file as per the requirement, 

Save as an XML file in AllFusion Repository Format. Copy the generated XML file to the 

location <<Extracted Installer Path>>/OFS_IFRS_PACK/OFS_IFRS/DataModel. 

 Connect to the database as a user with DBA privileges. Execute the following grant 

statement: 

GRANT CREATE TYPE TO [<ATOMIC SCHEMA>]; 

NOTE:  This grant should be executed for all existing Atomic Schemas. 

 Download the one-off patch 25343603 from My Oracle Support, if OFSAA is deployed on 

Oracle WebLogic Server version 12.2.x. 

 Download the consolidated one-off patch 25487272 from My Oracle Support. 

 Download the consolidated one-off patch 25777667 from My Oracle Support. 

NOTE:  Ensure that you backup the FSI_CURRENCIES table before the installation and 

restore after installation is complete. 

11..33  HHooww  ttoo  AAppppllyy  TThhiiss  MMiinnoorr  RReelleeaassee??  

11..33..11  IInnssttaalllliinngg  OOFFSS  IIFFRRSS  

Refer to the following instructions to download, extract, install, and configure this Minor Release. 

1. Login to https://support.oracle.com/ and search for 25433981 under the Patches & 

Updates tab. 

2. Download the OFS IFRS Application Pack v8.0.4.0.0 archive file and copy it to your 

OFSAA server in Binary mode. 

NOTE:  The archive files are different for every operating system like AIX, Solaris, and 

RHEL/Oracle Linux. 

3. Log in to the OFSAA Server. 

4. Shut down all the OFSAAI Services. For more information, refer to the Start/Stop 

Infrastructure Services section in Oracle Financial Services IFRS Release 8.0.0.0.0 

Installation Guide in OHC Documentation Library. 

5. Assign WRITE permission to the files/folders such as common scripts, 

EXEWebService, ficapp, ficweb, and ficdb in the $FIC_HOME folder by executing the 

command: 

https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
http://docs.oracle.com/cd/E60529_01/homepage.htm
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chmod -R 750 $FIC_HOME 

6. If you have Unzip utility, skip to the next step. Download the Unzip utility (OS-specific) 

and copy it in Binary mode to the directory that is included in your PATH variable, 

typically $HOME path or directory in which you have copied the OFS IFRS 8.0.4.0.0 

installer. 

 Uncompress the unzip installer file using the command: 

uncompress <unzip utility filename> 

NOTE:  In case you notice an error message “uncompress: not found [No 

such file or directory]” when the package is not installed, contact your 

UNIX administrator. 

 Give EXECUTE permission to the file using the command: 

chmod 751 OFS_IFRS_80400_<OperatingSystem>.zip. 

7. Extract the contents of the 8.0.4.0.0 archive file using the command: 

unzip_<os> -a <name of the file to be unzipped> 

The above -an option is mandatory. 

8. Give EXECUTE permission to the archive file. Navigate to the path 

OFS_IFRS_80400_<OperatingSystem>.zip and execute the command:  

chmod 750 OFSAAIUpdate.sh 

9. Configure the Param.conf file present under OFS_IFRS_PACK/OFS_IFRS/conf folder, 

as follows: 

 Model Upload Process: Enter either 0 or 1. 

 0  - Skip Model Upload 

 1 - Trigger Model Upload 

 If you have selected 1 in the previous step, select the option of the type of Model 

upload as either 0 or 1. 

 0 - Released Data Model  

 1 - Customized Data Model  

 If you have selected 1 in the previous step, provide the inputs for the Data Model 

Name and the Path of Data Model. 

10. Execute OFSAAIUpdate.sh file using the following command: 

./OFSAAIUpdate.sh 
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Verify if the Minor Release is applied successfully by checking the following log files 

generated in the installation folder: 

 <IFRS_Patch_Installer_Folder>/OFS_IFRS_PACK/logs/OFSAAIUpdate.log 

 <IFRS_Patch_Installer_Folder>/OFS_IFRS_PACK/OFS_IFRS/logs/<log> 

You can ignore the “Object already exists” warnings and ORA-00001, ORA-00955, 

ORA-02260, ORA-01430, and ORA-01031 errors in the log file. In case of any other 

errors, contact Oracle Support. 

11. If OFSAA is deployed on Oracle WebLogic Server version 12.2.x, install the one-off 

patch 25343603. Refer to the Readme available with the patch for further instructions 

on installing the patch. 

NOTE:  Refer to the Technology Matrix for a list of supported servers for OFSAAI 

8.0.4.0.0. 

12. Install the consolidated one-off patch 25487272. Refer to the Readme available with the 

patch for further instructions on installing the patch. 

13. .Install the consolidated one-off patch 25777667. Refer to the Readme available with 

the patch for further instructions on installing the patch. 

14. Verify the Update.log file located at 

$FIC_HOME/utility/UpdateConstraints/logs folder which is created by 

Update Constraint utility. 

Execution status information of the utility is available against each Information domain. 

For success, “Update successful” message is displayed. If it is successful, verify the 

following references for new constraint names: 

 ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml 

 Constraint scripts under ftpshare/<INFODOM>/erwin/scripts/table 

 Constraint scripts under ftpshare/<INFODOM>/scripts 

 Object registration tables for constraints, REV_TAB_CONSTRAINTS, 

REV_TAB_REF_CONSTRAINTS, REV_TAB_CONSTRAINT_COLUMNS. 

 Oracle Data Dictionary in the respective atomic schema for each Infodoms. 

In case of errors in the Update.log file, identify the failed Infodoms. Then troubleshoot 

and execute the standalone utility for the failed Infodoms. See How to execute the 

Update Constraints Utility section. 

15. After successful installation of this Minor Release, perform the following steps: 

 Clear the application cache. Navigate to the following path depending on the 

configured web application server and delete the files. 

https://support.oracle.com/
http://docs.oracle.com/cd/E55339_01/homepage.htm
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 Tomcat: 

<Tomcat installation folder>/work/Catalina/localhost/<Application 

name>/org/apache/jsp 

 Weblogic: 

<Weblogic installation location>/domains/<Domain name>/servers/<Server 

name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet 

 Websphere: 

<Websphere installation directory>/AppServer/profiles/<Profile 

name>/temp/<Node name>/server1/<Application name>/<.war file name> 

16. Add umask 0027 in the .profile of the UNIX account which manages the WEB 

server to ensure restricted access permissions. 

17. After the successful installation of the Minor Release, restart all the OFSAAI services. 

For more information, refer to the Start/Stop Infrastructure Services section in Oracle 

Financial Services IFRS Release 8.0.2.0.0 Installation Guide in OHC Documentation 

Library. 

18. Generate the application EAR/WAR file and redeploy the application onto your 

configured web application server. For more information on generating and deploying 

the EAR / WAR file, refer to the Post Installation Configuration section in Oracle 

Financial Services IFRS Release 8.0.2.0.0 Installation Guide in OHC Documentation 

Library. 

19. Navigate to Administration and Configuration > System Configuration > Manage 

OFSAA Product Licenses module of Oracle Financial Services Analytical 

Applications Infrastructure and license the applications. 

20. Navigate to Identity Management > User Administrator > User Group Domain Map 

module of Oracle Financial Services Analytical Applications Infrastructure and 

Map seeded HM and/or LLFP User Groups to the application domains. 

21. Navigate to Object Administration > Object Security > Batch Executions Rights 

module of Oracle Financial Services Analytical Applications Infrastructure and map the 

Seeded Batches to Mapped User Group, which is assigned to the user. 

NOTE:  Market Data providers are not seeded as those are user-specific. Market Data Providers can 

be added through the AMHM module of Oracle Financial Services Analytical Applications 

Infrastructure by updating the dimension ‘Financial Data Provider’ with names of subscribed 

market data providers. The market feed from such providers is held in Market Center Quote 

Staging table, where the Data Origin column contains a reference to market data provider. For 

more information on AMHM, see Oracle Financial Services Analytical Applications 

Infrastructure User Guide available in OHC Documentation Library. 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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11..44  PPoosstt  IInnssttaallll  CCoonnffiigguurraattiioonnss  

Download and install the following one-off patches from the Patches & Updates tab of 

https://support.oracle.com/: 

 25828416 

 25555593 

 27027637 

 28309853 

Execute the DMT Migration Utility to manually migrate the DMT metadata of the 

Applications which are not upgraded to 8.0.6.0.0. DMT migration utility is available as part 

of the OFSAAI 8.0.6.0.0 upgrade to migrate the DMT metadata (PLC/Data Source/Data 

Mapping/Data File Mapping) to be persisted in tables instead of XML. To identify when to 

migrate, what/how to migrate, and how to handle migration issues, see OFSAA DMT 

Metadata Migration Guide. 

Install the security patch for OFS IFRS from the MOS Document 2308427.1. 

11..44..11  DDaattaa  TTrraannssffoorrmmaattiioonn  RReessaavvee  

The valuation function - fair_value_transformation, for Level 3 contains only Level 1 and Level 

2 valuation codes and does not reflect the latest changes done to the function, concerning Level 

3.  

To reflect the changes for Level 3, update the fair_value_transformation function from the Post 

Load changes section of OFSAAI, by performing the following procedure: 

1. Navigate to Data Management Tools > Post Load Changes. 

The Post Load Changes section is displayed: 

 

https://support.oracle.com/
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=554996668356233&id=2308427.1
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2. Select the function fair_value_transformation form the LHS list. 

The details of the function are displayed in the RHS in Transformation Process Flow and 

Transformation Definition grids. 

3. Click  button. The Description field is enabled for editing. 

4. Click  button. 

The Parameter Definition, Stored Procedure Editor, and Business Process Flow grids are 

displayed. 

5. Click  button. The function is saved and a dialog box confirming the save 

operation is displayed. Click  button. 

11..44..22  UUppddaattee  CCoonnssttrraaiinnttss  UUttiilliittyy  

This utility applies a new naming convention to constraints (PK and FK) to resolve the following 

issues: 

 For tables with similar names which are relatively long (>27 characters) where the initial 

few characters differ (for example, STG_COMMON_ACCOUNT_SUMMARY, 

FCT_COMMON_ACCOUNT_SUMMARY), the constraint names get generated as 

same causing an Oracle error of duplicate constraints.  

 When the number of foreign keys for a table is more than 100, the length of the 

constraint name exceeds the permissible limits allowed by Oracle Database. 

The new naming convention has the following logic.  A Unique ID gets generated for each data 

model entities. The new constraint name will be generated by appending the unique ID with ‘FK’ 

or ’PK’ (along with a sequence for FK). For example, PK on DIM_ACCOUNT will be formed as 

PK_101, where 101 is the unique id of DIM_ACCOUNT. Similarly, FKs on 

FCT_ACCOUNT_SUMMARY will be FK_206_01, FK_206_02, FK_206_03, FK_206_04, where 

206 is the unique id of FCT_ACCOUNT_SUMMARY and the table has 4 FKs. 

This utility gets executed as part of the OFSAAI 8.0.4.0.0 patch installation. After the successful 

installation of the OFSAAI 8.0.4.0.0 installer patch, verify the Update.log file located at 

$FIC_HOME/utility/UpdateConstraints/logs folder that is created by Update 

Constraint utility. Else, the value of AAI_MU_UTIL_UPDATE_CONS. V_FLAG_VALUE of the 

Config Schema table. If its value is ‘N’ against an Infodom, it is identified as a failure.  

In case of errors, identify and troubleshoot the failed Infodoms. Once you have completed the 

troubleshooting, execute the standalone utility for the failed Infodoms. 

11..44..22..11  HHooww  ttoo  EExxeeccuuttee  tthhee  UUttiilliittyy  

Utility performs the backup of the following files under ftpshare/<INFODOM>_encon_bkp but 

restoration is not done. 
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 ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml 

 Constraint scripts under ftpshare/<INFODOM>/erwin/scripts/table 

 Constraint scripts under ftpshare/<INFODOM>/scripts 

To execute the utility, perform the following steps: 

1. Navigate to $FIC_HOME/utility/UpdateConstraints/bin/ folder and grant 

RWX (755) permissions for all executables (.sh files). 

2. Execute the utility manually for each of the failed information domains. 

$FIC_HOME/utility/UpdateConstraints/bin/execute.sh $INFODOM 

3. If the process is successful, verify the following references for new constraint names: 

 ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml 

 Constraint scripts under ftpshare/<INFODOM>/erwin/scripts/table 

 Constraint scripts under ftpshare/<INFODOM>/scripts 

 Object registration tables for constraints, REV_TAB_CONSTRAINTS, 

REV_TAB_REF_CONSTRAINTS, REV_TAB_CONSTRAINT_COLUMNS. 

 Oracle Data Dictionary in the respective atomic schema for each Infodoms.  

4. In case of failure, refer to the utility’s log and identify the cause of the failure. Resolve 

the issues before proceeding with the re-run of the utility. For more queries, contact 

Oracle Support Services. 

11..44..22..22  TTrroouubblleesshhoooottiinngg  

Utility goes through six different steps, which can be traced with the below messages.  

NOTE:  At every stage identify the cause of the failure and resolve the issues before 

proceeding with the re-run of the utility: 

Steps Description Action to be taken 
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Steps Description Action to be taken 

1 Generate Scripts and updating 

DATABASE.XML 

Step 1:  

Restore the file backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/fipxml/<INFODOM>_DATAB

ASE.xml to the destination 

ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml. 

Step 2:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/scripts/table to the 

destination folder ftpshare/<INFODOM>/erwin/scripts/table.  

Step 3:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/scripts to the destination folder 

ftpshare/<INFODOM>/scripts. 

Step 4:  

Re-run the utility. 

2 Triggering Object Registration Step 1:  

Restore the file backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/fipxml/<INFODOM>_DATAB

ASE.xml to the destination 

ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml. 

Step 2:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/scripts/table to the 

destination folder ftpshare/<INFODOM>/erwin/scripts/table.  

Step 3:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/scripts to the destination folder 

ftpshare/<INFODOM>/scripts. 

 Step 4:  

Re-run the utility. 
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Steps Description Action to be taken 

3 Gathering information about 

previous constraint names 

Step 1:  

Restore the file backed up at ftpshare/<INFODOM>_encon_bkp/ 

erwin/fipxml/<INFODOM>_DATABASE.xml to the destination 

ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml. 

Step 2:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/scripts/table to the 

destination folder ftpshare/<INFODOM>/erwin/scripts/table.  

Step 3:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/scripts to the destination folder 

ftpshare/<INFODOM>/scripts. 

Step 4:  

Re-run the utility. 
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Steps Description Action to be taken 

4 Alter constraints Step 1:  

Execute the following statements to drop the backup tables in Atomic 

Schema:  

Drop table REV_TAB_CONSTRAINTS_U; 

Drop Table REV_TAB_REF_CONSTRAINTS_U ;  

Drop table REV_TAB_CONSTRAINT_COLUMNS_U; 

Step 2:  

Restore the file backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/fipxml/<INFODOM>_DATAB

ASE.xml to the destination 

ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml. 

Step 3:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/scripts/table to the 

destination folder ftpshare/<INFODOM>/erwin/scripts/table.  

Step 4:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/scripts to the destination folder 

ftpshare/<INFODOM>/scripts. 

Step 5:  

Modify r_rename_cons.sql that is available in the   

$FIC_HOME/utility/UpdateConstraints/Scripts/<INFODOM> 

folder by adding semicolon at the end of each line.  

Step 6:  

Execute the file r_rename_cons.sql in the Infodom Atomic Schema.  

Note: Ignore any ORA errors related to ‘constraint does not exist’. 

Step 7:  

Re-run the utility. 
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Steps Description Action to be taken 

5 Clear data of previous constraints This can be considered as a successful case. However, the user needs 

to execute the following SQL commands. 

Step 1:  

Execute the following statements to drop the backup tables in Atomic 

Schema:  

Drop table REV_TAB_CONSTRAINTS_U; 

Drop Table REV_TAB_REF_CONSTRAINTS_U ;  

Drop table REV_TAB_CONSTRAINT_COLUMNS_U; 

Step 2 :  

Execute the statement in Configuration Schema, after replacing 

<INFODOM> with the respective information domain: 

UPDATE aai_mu_util_update_cons SET 

V_FLAG_VALUE='Y',V_UPDATE_DATE=SYSDATE where 

DSNID='<INFODOM>' 

6 Update Successful - 

11..44..33  SSaannddbbooxx  RReessaavvee  UUttiilliittyy  

A utility is provided to regenerate the CONSTRAINTS.XML as per the changes done as part of 

Update Constraints utility. The constraint XML is required for the sandbox data population which 

will store the foreign key names of all the tables.  

The XML files which will be re-generated are: 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox/CONSTRAINTS.xml 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox/<TABLE_NAME>.xml 

11..44..33..11  PPrreerreeqquuiissiitteess  

Update Constraints utility should have been run successfully on all the sandbox and production 

Infodoms. 

11..44..33..22  HHooww  ttoo  RRuunn  tthhee  UUttiilliittyy  

1. Navigate to $FIC_HOME/utility/sandboxutil/bin folder and grant RWX (755) 

permissions for all executables (.sh files). 

2. Execute the utility using the following command: 

./updatesandbox.sh 

3. Verify logs from $FIC_HOME/utility/sandboxutil/bin/nohup.out folder. 
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4. If the process is successful, verify the following references for new constraint names: 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox/CONSTRAINTS.xml 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox/<TABLE_NAME>.xml 

5. In case of failure, refer the utility's log and restore the backups for the file system. 

Execute the utility for the failed infodoms one by one using the following command: 

$FIC_HOME/utility/sandboxutil/bin/updatesandbox.sh $INFODOM. 

NOTE:  Utility does the backup of 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox folder as 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox_bkp, but 

restore is not done. Restore should be done manually in case of any failure. 

The backup folder will be created in the app ftpshare area. In case of any 

failure, the backup has to be replaced in the db ftpshare area also. 

For more queries, contact Oracle Support Services. 

11..44..44  UUppddaattee  EETTLLRReeppoossiittoorryy..xxmmll  FFiillee  

1. Shut down all OFSAAI Services. For more information, refer to the Start/Stop 

Infrastructure Services section in Oracle Financial Services IFRS Release 8.0.0.0.0 

Installation Guide in OHC Documentation Library. 

2. Take a backup of the file ETLRepository.xml, present in the location, 

$FIC_HOME/ftpshare/etlapphome/. 

3. Remove the following entry from the file ETLRepository.xml file: 

<DEFINITION ID="T2T_EMBEDDED_OPTIONS_SCH" ISLOOKUP="FALSE" 

LOADTYPE="TABLE_LOAD" MEMORYLOAD="FALSE" OWNER_INFODOM="FUSION" 

TYPE="EXTRACT"> 

<PROPERTIESCREATED>YES</PROPERTIESCREATED> 

<FTPSTATUS>YES</FTPSTATUS> 

<CREATEDBY>APPUSER</CREATEDBY> 

<CREATETIME>2012/10/4 01:05:27 AM</CREATETIME> 

<LASTMODIFIEDBY>APPUSER</LASTMODIFIEDBY> 

<LASTMODIFIEDTIME>2012/10/4 01:05:27 AM</LASTMODIFIEDTIME> 

<MAPPING> 

<INFODOMS> 

<INFODOM CTL_OR_FMT="NO" FTPSTATUS="YES" ID="FUSION"> 

http://docs.oracle.com/cd/E60529_01/homepage.htm
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   <TABLES> 

        <TABLE ID="FSI_D_EMBEDDED_OPTIONS_SCH"/> 

    </TABLES> 

</INFODOM> 

</INFODOMS> 

</MAPPING> 

</DEFINITION> 

4. Restart all OFSAAI services. For more information, refer to the Start/Stop Infrastructure 

Services section in Oracle Financial Services IFRS Release 8.0.0.0.0 Installation Guide 

in OHC Documentation Library. 

11..44..55  UUppddaattee  tthhee  PPrrooppeerrttiieess  ooff  iiffrrss--eeiirr..iinnii  FFiillee  

The behavior of the IFRS EIR engine is controlled by six execution properties, which are present 

in the ifrs-eir.ini located at $FIC_DB_HOME/conf folder. You can update these properties for the 

following purposes: 

Property Update Required/Function/Description 

EIR_CALC_SCRIPT This refers to the name of the stored procedure that computes/persists the EIR 

value. 

Typically, this should be left unmodified from the factory-setting. 

PARALLEL_TABLES Tune the engine performance. 

If more than one instrument table is attached to an ALM-process, you can perform 

the EIR calculation for these tables in parallel. 

For example, If you set this to 5, the EIR calculation for a max of 5 tablets will be 

started in parallel. 

If the property is not set or is set to an invalid value, it will default to 1 – serial 

mode. 

http://docs.oracle.com/cd/E60529_01/homepage.htm
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Property Update Required/Function/Description 

NUM_EIR_THREADS Tune the engine performance. 

If the instrument table has more than 1 instrument record, this property 

determines how many parallel EIR executions are launched – one for each 

instrument record. One database-connection will be opened for each instrument-

record. 

For example, if you set this to 5, then EIR calculation will be launched for 5 

instrument records at a time – each having its private connection to the database. 

By controlling (PARALLEL_TABLES) & (NUM_EIR_THREADS) properties, you 

can control how many sessions are connected to the database. 

NUM_ACCOUNTS Tune the engine performance. 

The engine queries the list of instrument IDs into memory and then iterates 

through these instrument IDs. Since there can be any number of instrument 

records, there may or may not be sufficient memory to load the list of instrument 

IDs. The engine, therefore, fetches the instrument IDs from the table(s) in smaller 

batches. The NUM_ACCOUNTS setting specifies that batch size.  

If the number is too low, that engine needs to query the instrument table multiple 

times, to load the next set of instrument IDs. 

OFSRM_EXECUTOR The EIR engine internally triggers the Cash Flow engine to generate the cash 

flows. The CFE, by design, expects a user ID as one of the inputs; all subsequent 

Cash Flow generation is done using the application preference of this user ID. By 

default, the EIR engine uses the last modified by / creator ID of the Cash Flow 

process, for the CFE execution. 

A different user ID can be forced by using this property. However, it implies that 

the ALM application preferences are available for this overridden user ID. 

By default, this setting is disabled in the application. 

IGNORE_CFE_ERROR By default, the EIR engine skips EIR computation if the Cash Flow generation 

process fails (that is, returns a non-zero exit status). 

If this property is set to Y (or y), the EIR computation is not skipped and EIR will 

be computed for the instruments, for which Cash Flows have been generated. 

By default, this setting is disabled in the application. 

11..44..66  CCrreeaattiinngg  GGlloobbaall  VVaarriiaabblleess  ffoorr  OOBBIIEEEE  

To create the global variables for OBIEE, in this release of IFRS application, perform the following 

procedure: 

1. Host the RPD and Catalog for LLFP solution as part of this release. 
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2. Login into OBIEE/analytics using the application URL. 

3. Click the Analytics link. 

 

4. Click and select the subject area as IFRS 9. 

 

5. The subject area details are displayed. 

Expand a folder and double click on any column from the subject area. 

Click the Edit formula menu item. 

 

6. Click the Variables tab and select the Global option from the menu. 
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7. Create a global variable with the following details: 

 Variable Name: denomination 

Value: case when '@{denomination}{in thousand}' = 'in thousand' then 1000 

else 1000000 end 

This variable is used to divide all amount values by thousand or million, 

depending on the selected criteria. 

 Variable Name: RSkey 

Value: case when "Run"."Run Execution Id" = '@{RunId}{1476270723292}' 

then "Run"."Run Skey" end 

 Variable Name: stage 

Value: "Previous IFRS9 Stages"."IFRS Stage Code" 

8. Refresh the materialized by executing the following queries: 

 EXECUTE 

DBMS_MVIEW.REFRESH(LIST=>'FCT_IFRS_STG_DETERMINATION_MV'); 

This refreshing of MV should be done when there is a change to the Stage 

Determination table. 

 EXECUTE 

DBMS_MVIEW.REFRESH(LIST=>'FCT_COLLECTIVE_ASSESSMENT_MV’); 

11..44..77  EEnnaabbllee  MMuullttiippllee  EECCLL  RRuunn  IIDDss  iinn  EECCLL  DDaasshhbbooaarrdd  

Perform the following procedure to enable Multiple ECL Run IDs in ECL Dashboard: 

1. Go to EDIT mode in ECL Dashboard. 

2. Select Prompt - Run Details link and go to EDIT mode. 

3. Click the Options tab, General tab, select the dropdown for Choice List Values. 

4. Select SQL Results. 

5. Enter an SQL query to modify the filter of Run ID selection. For example:  
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SELECT "Run"."Run Description" FROM "IFRS 9" WHERE "Run"."Run 

Type"=2 FETCH FIRST 65001 ROWS ONLY 

6. Save the settings. 

11..44..88  CCoonnffiigguurraattiioonnss  ffoorr  VVeerriiffyyiinngg  aanndd  EExxeeccuuttiinngg  PPDD  MMooddeell  

This configuration procedure is specific to OFS LLFP and is required only if you have a licensed 

OFSAAI Enterprise Modelling Framework. 

Once you license OFS AAAI, the following configurations must be made to use the PD Modelling 

feature in OFS LLFP application. These steps are required to verify and execute the PD model 

that is packaged with the LLFP application.  

NOTE:  Ensure that Oracle R Enterprise Server version 1.5 is installed on the database server 

and AAAI Runner Package is installed on the DB server before you perform these 

configurations. Also, you must access the application with the required privileges. 

1. Create a new schema with the following grants: 

grant create SESSION to <<schema_user>>; 

grant create PROCEDURE to <<schema_user>>; 

grant create SEQUENCE to <<schema_user>>; 

grant create TABLE to <<schema_user>>; 

grant create TRIGGER to <<schema_user>>; 

grant create VIEW to <<schema_user>>; 

grant create MATERIALIZED VIEW to <<schema_user>>; 

grant create SYNONYM to <<schema_user>>; 

2. Grant RQADMIN role to the Config schema user: 

GRANT RQADMIN TO <<config_schema>>; 

GRANT RQADMIN TO <<atomic_schema>>; 

GRANT RQADMIN TO <<pdmodel_schema>>; 

3. Create a new database from System Configuration menu. 

4. Add the TNS entry for the newly created database. 

5. Create a new Information Domain for Sandbox and create a new Segment. 

6. Map the Sandbox Infodom to the group LLFP Admin Group. 

7. Map the EMF groups to the LLFP admin user. 

8. Login to Config schema and execute the following script: 
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$FIC_HOME/scripts_OFS_IFRS_8.0.4.0.0/config/insert/ofs_llfp_aai_

menu_804.sql 

9. Log in as LLFP Admin user and create a Sandbox from the OFSAAI menu. Use the 

dataset IFRS ECL Consolidated for creating this Sandbox. 

10. Disable the FK constraint (FK_MF_MODEL_DS_QUERY_1) defined in the table 

MF_MODEL_DS_QUERY, in Config schema. 

11. Replace the place holders ##LLFPSBXINFODOM## and ##LLFPSANDBOX_ID## 

with Sandbox infodom name and Sandbox ID respectively, in the following tables of 

Config schema: 

 MF_MODEL_MASTER 

 MF_MODEL_SCRIPT_MASTER 

 MF_MODEL_DS_QUERY 

12. Enable the FK constraint FK_MF_MODEL_DS_QUERY_1, in Config schema. 

13. Update all the occurrences of the term “Timestamp” to “Date Time” in the following 

files, present in the folder ftpshare/<<SANDBOX_INFODOM>>/erwin/scripts/sandbox: 

 FSI_TRANSITION_MATRIX_MST.xml 

 FSI_PERIOD_TM_MAP_MST.xml 

 FSI_IFRS_ECON_SCENARIO_MST.xml 

Once these configurations are set, you can follow the OFSAAAI Installation Guide to view, 

execute, and deploy the model from Sandbox. For more information, see Oracle Financial 

Services Advanced Analytical Applications Infrastructure Application Pack Installation and 

Configuration Guide available in Oracle Help Centre Documentation Library.  

11..44..99  AAddddiittiioonnaall  CCoonnffiigguurraattiioonnss  

11..44..99..11  CCoonnffiigguurraattiioonnss  ffoorr  BBiigg  DDaattaa  PPrroocceessssiinngg  

You can refer to the Configurations for Big Data Processing section in the OFS Advanced 

Analytical Applications Infrastructure Application Pack Installation and Configuration Guide 

v8.0.2.0.0.  

11..44..99..22  CCoonnffiigguurraattiioonnss  ffoorr  EEnntteerrpprriissee  MMooddeelliinngg  

This section is applicable only if OFS Enterprise Modeling is licensed and enabled in your OFSAA 

instance. 

Perform the following configurations before you start using Enterprise Modeling framework on 

8.0.4.0.0: 

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
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1. Install OFS AAAI Runner package in the database server to execute ORE models. This 

is a mandatory step and you can find the Runner package in the 

$FIC_HOME/ficdb/lib folder. For more information, refer to the section Installing 

OFS AAAI Runner Package in the OFS Advanced Analytical Applications Infrastructure 

Application Pack Installation and Configuration Guide v8.0.2.0.0. 

2. Configure ORE 1.5 to load the Cairo library in Oracle Linux/RHEL 7 by creating a 

symbolic link from libtiff.so.3 to libtiff.so.5 for the ORE executions to 

succeed. Follow the steps given below to create a symbolic link: 

1. Login as root and change directory to /usr/lib64. 

2. Execute the following command: 

ln -s libtiff.so.5 libtiff.so.3 

NOTE:  Contact Oracle Support Services if you require further assistance on 

ORE 1.5. 

The following steps are not required if you have done this as part of the 8.0.3.0.0 

version. 

3. Sandbox Resave Utility is included in the 8.0.4.0.0 upgrade patch. If the log file in the 

path $FIC_HOME/utility/sandboxutil/logs has any error messages, execute the 

Sandbox Resave utility. For details, see the How to Run the Utility section.   

4. Resave all ORE-based models, if you are upgrading to OFS AAI 8.0.4.0.0 from an older 

version. For more information on running the model resave utility, see the Model 

Resave Utility section. 

11..44..99..33  CCoonnffiigguurraattiioonn  ffoorr  TToommccaatt  

You can refer to the Oracle Financial Services Analytical Applications Infrastructure Applications 

Infrastructure Administration Guide for information on configuration for Tomcat. 

11..44..99..44  CCoonnffiigguurraattiioonnss  ffoorr  IInnlliinnee  PPrroocceessssiinngg  EEnnggiinnee  ((IIPPEE))  

You can refer to the Oracle Financial Services Analytical Applications Infrastructure 

Administration Guide for information on configuration for IPE. 

11..44..99..55  CCoonnffiigguurraattiioonnss  ffoorr  PPrroocceessss  MMooddeelliinngg  FFrraammeewwoorrkk  

You can refer to the Oracle Financial Services Analytical Applications Infrastructure 

Administration Guide for information on configuration for the Process Modeling Framework.  

11..44..99..66  CCoonnffiigguurraattiioonnss  ffoorr  FFoorrmmss  MMaannaaggeerr  

You can refer to the Oracle Financial Services Analytical Applications Infrastructure 

Administration Guide for information on configuration for Forms Manager. 

http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
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11..44..99..77  CCoonnffiigguurraattiioonnss  ttoo  DDeeppllooyy  tthhee  LLLLFFPPBBII  AApppplliiccaattiioonn  

The following are the steps to configure the LLFPBI Analytics:  

Before you begin this process, ensure that Oracle Business Intelligence (Version 11.1.1.9.0) 

installation is completed and is available. 

1. Set the <Oracle BI Instance Home> directory. 

For example: /u01/OBIEE11G/instances/instance1 

2. Start WebLogic AdminServer.  

a. Set the <BI Domain Home> directory. 

i. For Example: 

/u01/OBIEE11G/user_projects/domains/bifoundation_domain 

b. Navigate to <BI Domain Home >/bin and execute the following command: 

nohup ./startWebLogic.sh & 

NOTE:  Bringing up this service may take a few minutes depending on your 

environment. Check the logs using the command: 

tail –f nohup.out 

3. Start Node Manager.  

a. Set the < WebLogic Server Home > directory>.  

For example: /u01/OBIEE11G/wlserver_10.3 

b. Navigate to <WebLogic Server Home>/server/bin and execute the following 

command: 

nohup ./startNodeManager.sh & 

4. Start WebLogic Managed Server (bi_server1).  

a. Login onto http://localhost:7001/console using your Administrator credentials 

created during platform install (Replace the hostname based on your setup).  

b. Under the Environment tab, click the Servers link. 
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The bi_server1 displays the shutdown state at this point. 

 

c. Click the Control tab.  

d. Select the bi_server1 line by clicking on the left tick box.  

e. Click the Start button at the top of the list and confirm starting this service. 

 

f. The state will update to the “RUNNING” mode after a few minutes. 

5. Start OBIEE services and login  

a. Starting services From EM screen: 
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i. Log in to the EM administration screen using the URL: http://localhost:7001/em 

(Replace the hostname and port number based on your setup). Use the login 

you created in BIEE installation to log in.  

ii. Expand the 'Business Intelligence' node on the left and choose the Core 

application.  

 

iii. Click the Overview Tab. 

 

iv. Click Restart (or Start) under the Manage System section.  

v. Click Yes on the dialog box to confirm the action. Wait for a message that 

confirms the successful restart. 

b. If the start process using EM is not successful and returning an error about 

OPMNCTL not up, follow the starting process with OPMNCTL.  

i. Open a command prompt, navigate to <Oracle BI Instance Home>/bin.  

ii. Execute the command ./opmnctl status. This displays the status of all the 

OBIEE core services  

iii. Execute the command ./opmnctl startall or ./opmnctl stopall depending on 

your requirement. 

6. Deploy RPD and web catalog file(s).  
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a. Navigate to folder $FIC_HOME/LLFP_DASHBOARDS/ which contains LLFP.rpd 

file and $FIC_HOME/LLFP_DASHBOARDS/ which contains LLFP.catalog file.  

i. Login to OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em).  

ii. Click on core application from the Business Intelligence tab on the left-hand 

side.  

iii. Under the core application, select the Deployment tab and click the Lock and 

Edit Configuration button located below the title core application. The 

following screen is displayed: 

 

iv. RPD Deployment: Select the Browse button available under the Upload BI 

Server Repository section and select the LLFP.rpd file from the local folder. 

Enter the Repository password ‘Administrator1’.  

v. Web catalog Deployment:  

 Create a new web catalog folder for the LLFPBI application through the 

Enterprise Manager of OBIEE. 

 Set the Catalog Location available under ‘BI Presentation Catalog’ as 

$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesComp

onent/$COM PONENT_NAME/catalog/LLFPBI.  

 Click Apply and then click Activate changes. The following pop up is 

displayed after successful activation.  
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 Click the Close button and switch to the Capacity management tab.  

 Restart the presentation services. Under the System Components 

Availability, select Presentation Services and click on Restart Selected 

option.  

 

vi. Once the Presentation Service is restarted, it displays the pop up notifying the 

successful restart. Click Close.  

vii. Verify that the new folder structure is created in the system. It can be found 

under path: <Oracle BI Instance Home> 

\bifoundation\OracleBIPresentationServicesComponent\coreapplication_obips1

\catalog\LLFPBI 

viii. This LLFPBI folder will be having a root folder which in turn contains three 

folders named shared, system, and users. 

 

b. Open the Catalog Manager  
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i. Navigate to File menu and open the catalog online (File->Open catalog) by 

giving the necessary credentials based on your setup (Type - (online), URL - 

(http://<ipaddress>:<port>/analytics/saw.dll).  

ii. Once the catalog is opened, it displays a folder structure on the left-hand side. 

Select the shared folder in the LHS tree structure.  

iii. Go to the ‘File’ menu and select ‘Unarchive’. It asks for the path for a file.  

iv. Browse the path of the archived catalog file saved in your local folder using the 

Browse button in the pop-up. Click OK.  

v. The catalog is unarchived in a specified location. A pop up for successful 

operation is displayed. Restart the presentation services once again.  

c. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) and login with 

credentials based on your setup. Verify the availability of the catalog. 

7. Configure tnsnames.ora file. 

a. Open tnsnames.ora file under the folder - <Oracle Home>/network/admin.  

b. Make sure that an entry is made in the tnsnames.ora file to connect to the atomic 

schema of the OFSAA application.  

c. Save the tnsnames.ora file.  

8. Configure the ODBC data source to connect to Oracle BI Server.  

a. Navigate to Control Panel>Administrative Tools>Data Sources (ODBC).  

b. Select the System DSN tab and click the Add button.  

c. Select a driver-specific to (Oracle BI Server 11g) and click the Finish button.  

d. Enter Name and Server details (specify the Host Name or IP Address of the BI 

Server) and click Next.  

e. Enter Oracle BI Server login id and password (Enter User Name and Password 

created at the time of OBIEE installation). Click Next.  

f. Click Finish.  

9. Modify the connection pool and set the properties.  

a. Open the OBI Administration tool.  

b. Select Start > Programs > Oracle Business Intelligence > BI Administration.  

c. Select File > Open > Online and select LLFP.rpd file. 

d. In the Open dialog box, select and open LLFP.rpd file. 

e. Enter the Repository password as ‘Administrator1’.  
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f. In the Physical layer, double-click the Connect Pool. The properties of 

Connection Pool LLFP is displayed. 

g. In the General tab, edit / check the following entries:  

i. Call Interface: (OCI 10g/11g).  

ii. Data source name: <tnsnames.ora entry created in the step 8.b connecting to 

OFSAA atomic schema>.  

iii. User name: <enter atomic db user name>.  

iv. Password: <enter atomic db user password>.  

v. Confirm password and Click OK to close the window.  

vi. Similarly, configure the connection pools for ‘LLFPBI’. 

NOTE:  Repeat similar steps from (g) above for connection pool 'Connection 

Pool MR' under Database 'Market Risk'.  

vii. Click Save to save the RPD file.  

viii. Click No for the Global Consistency Message.  

ix. Close the RPD file (File / Exit).  

10. Login into LLFPBI Application using the URL: http://localhost:<port 

number>/analytics.(Replace the port number based on your setup). 

11..44..99..88  CCoonnffiigguurraattiioonn  ttoo  EEnnaabbllee  AAnnaallyyttiiccss  LLiinnkk  iinn  AApppplliiccaattiioonn  UURRLL  

To enable the Analytics link in the application URL, update the V_MENU_URL column of the 

Config table AAI_MENU_B with the Analytics URL, where the value of column V_MENU_ID is 

OFS_LLFP_ANALYTICS. 

For example: 

select V_MENU_URL from aai_menu_b where V_MENU_ID = 

'OFS_LLFP_ANALYTICS' ; 

11..44..99..99  CCoonnffiigguurraattiioonn  ttoo  SSaavvee  AALLMM  PPrroocceessss  ffrroomm  tthhee  UUII  wwhhiillee  uussiinngg  WWeebbSSpphheerree  

When you use WebSphere, ensure that the patch 25574885 has been downloaded and installed 

from the Patches & Updates tab of https://support.oracle.com page. This patch is required to save 

ALM processes while using WebSphere. 

 

http://localhost:%3cport
https://support.oracle.com/
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AAppppeennddiixx  AA  

FFrreeqquueennttllyy  AAsskkeedd  QQuueessttiioonnss  

WWhhaatt  cchheecckkss  ddooeess  tthhee  88..00..44..00..00  CCAA  RReelleeaassee  ppaattcchh  ppeerrffoorrmm??  

 Environment Check- As part of the environment check, it performs Java validation, Environment 

Variables validation, OS-specific validation, DB specific validation, and it shuts down all OFSAAI 

Services (Infrastructure Server, ICC Server, and back-end services). 

 Post Install check- As part of the Post-install check, it checks if OFSAAI services can be 

successfully started.  

WWhhiicchh  vveerrssiioonn  ooff  EERRwwiinn  DDaattaa  MMooddeelleerr  ddooeess  OOFFSSAAAAII  ssuuppppoorrtt??  

The references to Data Modeler ERwin versions 70, 71, 72, 90, 92, and 96 are provided for the OFSAAI 

framework to support these for backward compatibility. However, the data model-slices shipped with OFS 

IFRS 8.0.4.0.0 application pack are compatible with Erwin versions 9.5 and 9.64. 

WWhhaatt  sshhoouulldd  II  ddoo  ffoorr  vviieewwiinngg  tthhee  lloogg  ffiilleess  iinn  tthhee  DDeebbuugg  lleevveell  ffoorr  ttrroouubblleesshhoooottiinngg??  

By default, the log level is set as INFO. You need to manually change it to Debug to view the log files in 

the debug level. Based on your requirement, you can change the log level to Warn, Error, or Fatal as well. 

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

 Change the priority value to Debug in the RevLog4jConfig.xml file. 

For example: 

<root>  

  <priority value ="debug" />  

  <appender-ref ref="ConsoleAppender1"/>  

</root> 

 Change the value of LOGGERLEVEL in the DynamicServices.xml file from 20 to 0. (20 

is the value for Info and 0 for Debug.) 

NOTE:  For multi-tier installation, you need to change the log level to Debug in the 

DynamicServices.xml and RevLog4jConfig.xml files, which are present in 

$FIC_APP_HOME/conf, $FIC_DB_HOME/conf, and $FIC_WEB_HOME/conf 

as well. 

2. Navigate to $FIC_WEB_HOME/webroot/conf and change the priority value to Debug in the 

ExportLog4jConfig.xml, MDBLogger.xml, and PR2Logger.xml files for viewing log files in Debug 

level for the modules Archive/Restore, Metadata Browser, and RRF respectively. 



  OFS IFRS 8.0.4.0.0 Installation Guide 

 

36 

3. Generate the application EAR/WAR file and redeploy the application onto your configured web 

application server. For more information on generating and deploying the EAR / WAR file, refer to 

the Post Installation Configuration section in OFS IFRS Pack Installation and Configuration Guide 

– Release 8.0.2.0.0, available in OHC Documentation Library. 

4. Restart the OFSAAI Services (APP and WEB). For more information, refer to the Start/Stop 

Infrastructure Services section in OFS IFRS Pack Installation and Configuration Guide – Release 

8.0.2.0.0, available in OHC Documentation Library. 

 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm


 

 

37 

 

 

OFS IFRS 8.0.4.0.0 Installation Guide 

 

Oracle Corporation 

World Headquarters 

500 Oracle Parkway 

Redwood Shores, CA 94065 

U.S.A. 

 

Worldwide Inquiries: 

Phone: +1.650.506.7000 

Fax: +1.650.506.7200 

www.oracle.com/us/industries/financial-services/ 

 

Copyright © 2017 Oracle Financial Services Software Limited. All rights reserved. 

 

No part of this work may be reproduced, stored in a retrieval system, adopted or transmitted in any form or by any means, electronic, mechanical, photographic, 

graphic, optic recording or otherwise, translated in any language or computer language, without the prior written permission of Oracle Financial Services Software 

Limited. 

 

Due care has been taken to make this 8.0.4.0.0 Installation Guide and accompanying software package as accurate as possible. However, Oracle Financial Services 

Software Limited makes no representation or warranties with respect to the contents hereof and shall not be responsible for any loss or damage caused to the user 

by the direct or indirect use of this 8.0.4.0.0 Installation Guide and the accompanying Software System. Furthermore, Oracle Financial Services Software Limited 

reserves the right to alter, modify or otherwise change in any manner the content hereof, without obligation of Oracle Financial Services Software Limited to notify 

any person of such revision or changes.  

 

All company and product names are trademarks of the respective companies with which they are associated. 

 


	Audience
	How this Guide is Organized
	1 OFS IFRS Pack Release 8.0.4.0.0
	1.1 Supported Software Versions
	1.2 Pre Installation Requirements
	1.3 How to Apply This Minor Release?
	1.3.1 Installing OFS IFRS

	1.4 Post Install Configurations
	1.4.1 Data Transformation Resave
	1.4.2 Update Constraints Utility
	1.4.2.1 How to Execute the Utility
	1.4.2.2 Troubleshooting

	1.4.3 Sandbox Resave Utility
	1.4.3.1 Prerequisites
	1.4.3.2 How to Run the Utility

	1.4.4 Update ETLRepository.xml File
	1.4.5 Update the Properties of ifrs-eir.ini File
	1.4.6 Creating Global Variables for OBIEE
	1.4.7 Enable Multiple ECL Run IDs in ECL Dashboard
	1.4.8 Configurations for Verifying and Executing PD Model
	1.4.9 Additional Configurations
	1.4.9.1 Configurations for Big Data Processing
	1.4.9.2 Configurations for Enterprise Modeling
	1.4.9.3 Configuration for Tomcat
	1.4.9.4 Configurations for Inline Processing Engine (IPE)
	1.4.9.5 Configurations for Process Modeling Framework
	1.4.9.6 Configurations for Forms Manager
	1.4.9.7 Configurations to Deploy the LLFPBI Application
	1.4.9.8 Configuration to Enable Analytics Link in Application URL
	1.4.9.9 Configuration to Save ALM Process from the UI while using WebSphere



	Appendix A

